# Contents

1 Introduction .................................................................................................................................. 7

2 Installing MSP430 GCC Compiler ................................................................................................. 7
   2.1 Installing MSP430 GCC in CCS ......................................................................................... 8
   2.2 Installing MSP430 GCC as Stand-Alone Package .............................................................. 10

3 Using MSP430 GCC Within CCS .................................................................................................. 11
   3.1 Create New Project ............................................................................................................. 11
   3.2 Debug Using MSP-FET, MSPFET430UIF, eZ-FET, eZ430 .................................................. 12
   3.3 Build Options for MSP430 GCC ....................................................................................... 12
   3.4 Change an Existing CCS project That Uses TI Compiler to MSP430 GCC ......................... 33
   3.5 Create a New CDT Project Using MSP430 GCC ............................................................... 33
   3.6 GDB With MSP430 and CCSv6 ......................................................................................... 33
   3.7 CCS Compared to MSP430 GCC ....................................................................................... 33

4 MSP430 GCC Stand-Alone Package .............................................................................................. 33
   4.1 MSP430 GCC Stand-Alone Packages ............................................................................... 33
   4.2 Package Content ................................................................................................................. 35
   4.3 MSP430 GCC Options ....................................................................................................... 35
   4.4 MSP430 Built-in Functions .............................................................................................. 36
   4.5 MSP430 GCC Interrupts Definition .................................................................................. 37
   4.6 Quick Start: Blink the LED ............................................................................................... 37
   4.7 GDB Settings ..................................................................................................................... 39

5 Building MSP430 GCC From Sources .......................................................................................... 40
   5.1 Required Tools ................................................................................................................... 40
   5.2 Building MSP430 GCC (Somnium) ................................................................................... 40
   5.3 Building MSP430 GCC (Red Hat) .................................................................................... 41
   5.4 Building MSP430 GCC Stand-Alone Full Package ............................................................ 42

6 MSP430 GCC and MSPGCC ......................................................................................................... 43
   6.1 Calling Convention ............................................................................................................. 43
   6.2 Other Portions of the ABI ................................................................................................... 43

7 Appendix .......................................................................................................................................... 44
   7.1 GCC Intrinsic Support ....................................................................................................... 44
   7.2 GCC Function Attribute Support ..................................................................................... 45

8 References ...................................................................................................................................... 45

Revision History .................................................................................................................................. 46
# List of Figures

<table>
<thead>
<tr>
<th>Figure</th>
<th>Description</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>MSP430 GCC With CCS Installer</td>
<td>8</td>
</tr>
<tr>
<td>2</td>
<td>MSP430 GCC With CCS Installer</td>
<td>8</td>
</tr>
<tr>
<td>3</td>
<td>Installing MSP430 GCC Through CCS Apps Center</td>
<td>9</td>
</tr>
<tr>
<td>4</td>
<td>MSP430 GCC Stand-Alone Package Installer</td>
<td>10</td>
</tr>
<tr>
<td>5</td>
<td>MSP430 GCC Stand-Alone Package Installation Directory</td>
<td>10</td>
</tr>
<tr>
<td>6</td>
<td>Creating New CCS Project Using MSP430 GCC</td>
<td>11</td>
</tr>
<tr>
<td>7</td>
<td>CCS Project Using MSP430 GCC</td>
<td>12</td>
</tr>
<tr>
<td>8</td>
<td>MSP430 GCC Settings</td>
<td>13</td>
</tr>
<tr>
<td>9</td>
<td>MSP430 GCC Settings: Runtime</td>
<td>14</td>
</tr>
<tr>
<td>10</td>
<td>MSP430 GCC Settings: Symbols</td>
<td>16</td>
</tr>
<tr>
<td>11</td>
<td>MSP430 GCC Settings: Directories</td>
<td>17</td>
</tr>
<tr>
<td>12</td>
<td>MSP430 GCC Settings: Optimization</td>
<td>18</td>
</tr>
<tr>
<td>13</td>
<td>MSP430 GCC Settings: Preprocessor</td>
<td>20</td>
</tr>
<tr>
<td>14</td>
<td>MSP430 GCC Settings: Assembler</td>
<td>21</td>
</tr>
<tr>
<td>15</td>
<td>MSP430 GCC Settings: Debugging</td>
<td>22</td>
</tr>
<tr>
<td>16</td>
<td>MSP430 GCC Settings: Diagnostic Options</td>
<td>23</td>
</tr>
<tr>
<td>17</td>
<td>MSP430 GCC Settings: Miscellaneous</td>
<td>24</td>
</tr>
<tr>
<td>18</td>
<td>MSP430 GCC Linker Settings</td>
<td>25</td>
</tr>
<tr>
<td>19</td>
<td>MSP430 GCC Linker Basic Settings</td>
<td>26</td>
</tr>
<tr>
<td>20</td>
<td>MSP430 GCC Linker Libraries Settings</td>
<td>27</td>
</tr>
<tr>
<td>21</td>
<td>MSP430 GCC Linker Symbols Settings</td>
<td>28</td>
</tr>
<tr>
<td>22</td>
<td>MSP430 GCC Linker Miscellaneous Settings</td>
<td>29</td>
</tr>
<tr>
<td>23</td>
<td>MSP430 GCC GNU Objcopy Utility Settings</td>
<td>30</td>
</tr>
<tr>
<td>24</td>
<td>MSP430 GCC GNU Objcopy Utility General Options Settings</td>
<td>31</td>
</tr>
<tr>
<td>25</td>
<td>MSP430 GCC GNU Objcopy Utility Miscellaneous Settings</td>
<td>32</td>
</tr>
<tr>
<td>Table</td>
<td>Description</td>
<td>Page</td>
</tr>
<tr>
<td>-------</td>
<td>-----------------------------------------------------------</td>
<td>------</td>
</tr>
<tr>
<td>1</td>
<td>MSP430 TI and GCC Compilers Comparison</td>
<td>7</td>
</tr>
<tr>
<td>2</td>
<td>MSP430 GCC Settings</td>
<td>14</td>
</tr>
<tr>
<td>3</td>
<td>MSP430 GCC Settings: Runtime</td>
<td>15</td>
</tr>
<tr>
<td>4</td>
<td>MSP430 GCC Settings: Symbols</td>
<td>16</td>
</tr>
<tr>
<td>5</td>
<td>MSP430 GCC Settings: Directories</td>
<td>17</td>
</tr>
<tr>
<td>6</td>
<td>MSP430 GCC Settings: Optimization</td>
<td>19</td>
</tr>
<tr>
<td>7</td>
<td>MSP430 GCC Settings: Preprocessor</td>
<td>20</td>
</tr>
<tr>
<td>8</td>
<td>MSP430 GCC Settings: Assembler</td>
<td>21</td>
</tr>
<tr>
<td>9</td>
<td>MSP430 GCC Settings: Debugging</td>
<td>22</td>
</tr>
<tr>
<td>10</td>
<td>MSP430 GCC Settings: Diagnostic Options</td>
<td>23</td>
</tr>
<tr>
<td>11</td>
<td>MSP430 GCC Settings: Miscellaneous</td>
<td>24</td>
</tr>
<tr>
<td>12</td>
<td>MSP430 GCC Linker Settings</td>
<td>25</td>
</tr>
<tr>
<td>13</td>
<td>MSP430 GCC Linker Basic Settings</td>
<td>26</td>
</tr>
<tr>
<td>14</td>
<td>MSP430 GCC Linker Libraries Settings</td>
<td>28</td>
</tr>
<tr>
<td>15</td>
<td>MSP430 GCC Linker Symbols Settings</td>
<td>29</td>
</tr>
<tr>
<td>16</td>
<td>MSP430 GCC Linker Miscellaneous Settings</td>
<td>29</td>
</tr>
<tr>
<td>17</td>
<td>MSP430 GCC GNU Objcopy Utility Settings</td>
<td>30</td>
</tr>
<tr>
<td>18</td>
<td>MSP430 GCC GNU Objcopy Utility General Options Settings</td>
<td>31</td>
</tr>
<tr>
<td>19</td>
<td>MSP430 GCC GNU Objcopy Utility Miscellaneous Settings</td>
<td>33</td>
</tr>
<tr>
<td>20</td>
<td>MSP430 GCC Stand-Alone Package</td>
<td>34</td>
</tr>
<tr>
<td>21</td>
<td>MSP430 GCC Command Options</td>
<td>35</td>
</tr>
</tbody>
</table>
Preface: Read This First

How to Use This User's Guide

This manual describes only the setup and basic operation of the MSP430™ GCC compiler and the software development environment. It does not fully describe the MSP430 GCC compiler or MSP430 microcontrollers or the complete development software and hardware systems. For details on these items, see the appropriate documents listed in Related Documentation.

This manual applies to the use of MSP430 GCC as stand-alone package or within the Code Composer Studio™ (CCS) IDE v6.1 and with the TI MSP-FET, MSP-FET430UIF, eZ-FET, and eZ430 development tools series.

These tools contain the most up-to-date materials available at the time of packaging. For the latest materials (including data sheets, user’s guides, software, and application information), visit the TI MSP430 website or contact your local TI sales office.

Information About Cautions and Warnings

This document may contain cautions and warnings. The information in a caution or a warning is provided for your protection. Read each caution and warning carefully.

CAUTION
This is an example of a caution statement.
A caution statement describes a situation that could potentially damage your software or equipment.

WARNING
This is an example of a warning statement.
A warning statement describes a situation that could potentially cause harm to you.

Related Documentation

The primary sources of MSP430 information are the device-specific data sheets and user’s guides. The MSP430 website contains the most recent version of these documents.

The GCC documentation can be found at http://www.gnu.org. All related information for the MSP430 GCC compiler is available at http://www.ti.com/tool/msp430-gcc-opensource.
Documents that describe the Code Composer Studio tools (CCS IDE, assembler, C compiler, linker, and librarian) can be found at http://www.ti.com/tool/ccstudio. A CCS-specific Wiki page (FAQ) and the TI E2E™ Community support forums provide additional help.

**MSP430 GCC documentation**


*GDB: The GNU Project Debugger*, Free Software Foundation, Inc. (https://sourceware.org/gdb/current/onlinedocs/)

*Red Hat GCC for MSP430™ Microcontrollers Quick Start Guide*

*Calling Convention and ABI Changes in MSP GCC*

**CCS v6.1 documentation**

*MSP430™ Assembly Language Tools User's Guide*

*MSP430™ Optimizing C/C++ Compiler User's Guide*

*Code Composer Studio™ v6.1 for MSP430™ User's Guide*

**MSP430 development tools documentation**

*MSP430™ Hardware Tools User's Guide*

eZ430-F2013 Development Tool User's Guide

eZ430-RF2480 User's Guide

eZ430-RF2500 Development Tool User's Guide

eZ430-RF2500-SEH Development Tool User's Guide

eZ430-Chronos™ Development Tool User's Guide

*MSP-EXP430G2 LaunchPad™ Development Kit User's Guide*

*Advanced Debugging Using the Enhanced Emulation Module (EEM) With Code Composer Studio Version 6*

**MSP430 device data sheets**

**MSP430 device family user’s guides**

*MSP430x1xx Family User's Guide*

*MSP430x2xx Family User's Guide*

*MSP430x3xx Family User's Guide*

*MSP430x4xx Family User's Guide*

*MSP430x5xx and MSP430x6xx Family User's Guide*

*MSP430FR4xx and MSP430FR2xx Family User's Guide*

*MSP430FR57xx Family User's Guide*


**If You Need Assistance**

Support for the MSP430 devices and the hardware development tools is provided by the TI Product Information Center (PIC). Contact information for the PIC can be found on the TI website. The TI E2E Community support forums for the MSP430 provide open interaction with peer engineers, TI engineers, and other experts. Additional device-specific information can be found on the MSP430 website.
1 Introduction

TI has partnered with SOMNIUM® Technologies Limited (http://somniumtech.com) (previously with Red Hat until first quarter 2016) to bring you a new and fully supported open-source compiler as the successor to the community driven MSPGCC. The MSP430 GCC uses the MSP430 ABI and is compatible with the TI compiler. This free GCC compiler supports all MSP430 devices and has no code size limit. In addition, this compiler can be used as a stand-alone package or used within Code Composer Studio (CCS) IDE v6.0 or later. Get started today in Windows, Linux, or OS X environments.

Table 1 compares the MSP430 TI and GCC compilers.

<table>
<thead>
<tr>
<th>Compiler</th>
<th>Proprietary TI Compiler</th>
<th>MSP430 GCC</th>
<th>MSPGCC</th>
</tr>
</thead>
<tbody>
<tr>
<td>Code Size and Performance</td>
<td>✓ ✓ ✓ ✓ ✓</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>ABI</td>
<td>TI</td>
<td>TI</td>
<td>Community</td>
</tr>
<tr>
<td>Integrated in CCS</td>
<td>✓</td>
<td>✓ (1)</td>
<td>x</td>
</tr>
<tr>
<td>Stand-alone</td>
<td>x</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>Support</td>
<td>TI</td>
<td>TI</td>
<td>Community</td>
</tr>
<tr>
<td>Cost Free</td>
<td>x</td>
<td>✓</td>
<td>✓</td>
</tr>
</tbody>
</table>

(1) The combination of CCS+GCC is completely free of charge with no code size limit.

The MSP430 GCC supports the following:
- MSP430 CPU 16-bit architecture
- MSP430 CPUX 20-bit architecture
- MSP430 CPUXv2 20-bit architecture
- Code and data placement in the lower (<64K) and upper (>64K) memory areas and across the memory boundary
- The hardware multiplier of the MSP430 microcontrollers

This manual describes the use of the MSP430 GCC compiler with the MSP430 ultra-low-power microcontrollers. The MSP430 GCC compiler can be used within CCS version 6.0 or later, or it can be used as a stand-alone package. The compiler supports Windows®, Linux®, and OS X® operating systems. This manual describes only CCS for Windows operating systems. The versions of CCS for Linux and OS X operating systems are similar and, therefore, are not described separately.

2 Installing MSP430 GCC Compiler

MSP430 GCC supports Windows, Linux, and OS X:
- Windows XP 32 bit or 64 bit
- Windows 7 32 bit or 64 bit
- Windows 8 32 bit or 64 bit
- Windows 10 32 bit or 64 bit
- Linux 32 bit or 64 bit
- OS X 64 bit

The MSP430 GCC can be installed using two methods.
1. MSP430 GCC can be installed within CCS v6.0 and higher. The MSP430 GCC (compiler only) is available in the CCS Apps Center. The corresponding MSP430 GCC support files (header and linkers) are downloaded with a standard emulation package. For details, see Section 2.1.
2. MSP430 GCC can be also downloaded as stand-alone package. For details, see Section 2.2.
2.1 Installing MSP430 GCC in CCS

MSP430 GCC compiler can be installed within CCS v6.0 or higher in two ways: either when CCS is installed or as an add-on to an existing CCS installation.

1. During the install process of CCSv6.0, select the MSP430 GCC compiler to be installed as an "add-on" (see Figure 1). MSP430 GCC is installed the first time you run CCS (see Figure 2).

![Figure 1. MSP430 GCC With CCS Installer](image1)

![Figure 2. MSP430 GCC With CCS Installer](image2)
2. If CCS is already installed without MSP430 GCC, MSP430 GCC can be added at a later time through the CCS Apps Center (see Figure 3).
   (a) Go to the menu View → CCS App Center.
   (b) Select MSP430 GCC
   (c) Click the Install Software button to start the installation.

3. After installation is complete, the GCC compiler tools are in the following directory within the CCS installation: `ccsv6\tools\compiler\gcc_msp430_x.x.x` (where xxx denotes the version number).
2.2 Installing MSP430 GCC as Stand-Alone Package

The MSP430 GCC full stand-alone package can be downloaded from the TI website for all supported operating systems. The MSP430 GCC stand-alone package contains the compiler, device support files, debug stack, and USB drivers.

To install the package:
1. Download the corresponding package installer and run it (see Figure 4).

![Figure 4. MSP430 GCC Stand-Alone Package Installer](image)

2. Select the install directory and click **Next** (see Figure 5).

![Figure 5. MSP430 GCC Stand-Alone Package Installation Directory](image)

**NOTE:** For the Linux installer, apply `sudo chmod +x <installer>` before executing the package.
3 Using MSP430 GCC Within CCS

3.1 Create New Project

This section describes the step-by-step instructions to create an assembly or C project from scratch and to download and run an application on the MSP430 MCU using the MSP430 GCC compiler. Also, the CCS Help presents a more detailed information of the process.

1. Start CCS (Start → All Programs → Texas Instruments → Code Composer Studio → Code Composer Studio).

2. Create a new project (File → New → CCS Project). Select the appropriate MSP430 device variant in the Target field and enter the name for the project.

3. Select GNU v5.3.0 (Somnium) for Compiler version (or any newer version).

4. In the Project template and examples section, select Empty Project (with main.c). For assembly-only projects, select Empty Project.

![Figure 6. Creating New CCS Project Using MSP430 GCC](image)

5. If you are using a USB Flash Emulation Tool such as the MSP-FET, MSP-FET430UIF, eZ-FET, or the eZ430 Development Tool, they should be already configured by default.

6. For C projects, the setup is complete now.

7. Click Finish to create a new project that is then visible in the Project Explorer view.

   Notice that the project contains a .ld file (appropriate for the target selected). This is the linker script that contains the memory layout and section allocation. This file is the equivalent of the TI linker command file (.cmd) used by TI MSP430 Compiler and Linker.

8. Enter the program code into the main.c file.

   To use an existing source file for the project, click Project → Add Files... and browse to the file of interest. Single click on the file and click Open or double-click on the file name to complete the addition of it into the project folder.

   Now add the necessary source files to the project and build. Similar to TI tools, additional compiler and linker options can be set from Project Properties.

9. Build the project (Project → Build Project).
10. Debug the application (Run → Debug (F11)). This starts the debugger, which gains control of the target, erases the target memory, programs the target memory with the application, and resets the target.

11. Click Run → Resume (F8) to start the application.

12. Click Run → Terminate to stop the application and to exit the debugger. CCS automatically returns to the C/C++ view (code editor).

3.2 Debug Using MSP-FET, MSPFET430UIF, eZ-FET, eZ430

MSP430 devices can be debugged in CCS using MSP-FET, MSPFET430UIF, eZ-FET, and eZ430 debuggers. For more details, refer to the Code Composer Studio™ v6.1 for MSP430™ User’s Guide.

3.3 Build Options for MSP430 GCC

The settings required to configure the GCC are numerous and detailed and are not all described here. Most projects can be compiled and debugged with default factory settings.

To access the project settings for the active project, click Project → Properties.

The following project settings are common:

- Specify the target device for debug session (Project → Properties → General → Device → Variant). The corresponding Linker Command File and Runtime Support Library are selected automatically.
To more easily debug a C project, disable optimization (Project → Properties → Build → GNU Compiler → Optimization → Optimization level).

Specify the search paths for the C preprocessor (Project → Properties → Build → GNU Compiler → Directories → Include Paths (-I)).

Specify the search paths for any libraries being used (Project → Properties → Build → GNU Linker → Libraries → Library search path (-L, --library-path)).

Specify the debugger interface (Project → Properties → General → Device → Connection). Select TI MSP430 USBx for the USB interface.

Enable the erasure of the Main and Information memories before object code download (Project → Properties → Debug → MSP430 Properties → Download Options → Erase Main and Information Memory).

To ensure proper stand-alone operation, select Hardware Breakpoints (Project → Properties → Debug → MSP430 Properties). If Software Breakpoints are enabled (Project → Properties → Debug → Misc/Other Options → Allow software breakpoints to be used), ensure proper termination of each debug session while the target is connected. Otherwise, the target may not work as expected stand-alone as the application on the device still contains the software breakpoint instructions.

3.3.1 GNU Compiler

Figure 8 shows the MSP430 GCC settings window.
Table 2 describes the options that are available for MSP430 GCC Settings.

Table 2. MSP430 GCC Settings

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Command</td>
<td>Compiler location</td>
</tr>
<tr>
<td>Command-line pattern</td>
<td>Command line parameters</td>
</tr>
<tr>
<td>Summary of flags set</td>
<td>Command line with which the compiler is called. Displays all the flags passed to the compiler.</td>
</tr>
</tbody>
</table>

3.3.2 GNU Compiler: Runtime

Figure 9 shows the MSP430 GCC Runtime settings window.

![Figure 9. MSP430 GCC Settings: Runtime](image-url)
Table 3 describes the options that are available for MSP430 GCC Runtime settings.

### Table 3. MSP430 GCC Settings: Runtime

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Target CPU (-mcpu)</td>
<td>Specifies the Instruction Set Architecture (ISA) to use. Accepted values are msp430, msp430x, and msp430xv2. This option is deprecated. The ‘-mmcu=’ option should be used to select the ISA.</td>
</tr>
<tr>
<td>Target MCU (-mmcu)</td>
<td>Select the MCU to target. This is used to create a C preprocessor symbol based on the MCU name, converted to upper case and prefixed and postfixed with __. This in turn is used by the msp430.h header file to select an MCU-specific supplementary header file. The option also sets the ISA to use. If the MCU name is one that is known to only support the 430 ISA then that is selected, otherwise the 430X ISA is selected. A generic MCU name of msp430 can also be used to select the 430 ISA. Similarly the generic msp430x MCU name selects the 430X ISA. In addition, an MCU-specific linker script is added to the linker command line. The script’s name is the name of the MCU with “.ld” appended. Thus, specifying ‘-mmcu=xxx’ on the gcc command line defines the C preprocessor symbol <strong>XXX</strong> and causes the linker to search for a script called ‘xxx.ld’. This option is also passed to the assembler.</td>
</tr>
</tbody>
</table>
| Generate run time type descriptor information | Enable or disable generation of information about every class with virtual functions for use by the C++ runtime type identification features.  
   • On (-frtti)  
   • Off (-fno-rtti) |
| Enable exception handling | Enable or disable exception handling. Generates extra code needed to propagate exceptions.  
   • On (-fexceptions)  
   • Off (-fno-exceptions) |
3.3.3 GNU Compiler: Symbols

Figure 10 shows the MSP430 GCC Symbols settings window.

Table 4 describes the options that are available for MSP430 GCC Symbols settings.

Table 4. MSP430 GCC Settings: Symbols

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Define symbols (-D)</td>
<td>-D name&lt;br&gt;Predefine name as a macro.&lt;br&gt;-D name=definition&lt;br&gt;Predefine name as a macro, with definition 1.</td>
</tr>
<tr>
<td>Undefine symbols (-U)</td>
<td>-U name&lt;br&gt;Cancel any previous definition of name, either built in or provided with a -D option.</td>
</tr>
</tbody>
</table>
### GNU Compiler: Directories

Figure 11 shows the MSP430 GCC Directories settings window.

![Figure 11. MSP430 GCC Settings: Directories](image)

Table 5 describes the options that are available for MSP430 GCC Directories settings.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Include paths (-I)</td>
<td>Add the directory to the list of directories to be searched for header files.</td>
</tr>
</tbody>
</table>
3.3.5 GNU Compiler: Optimization

Figure 12 shows the MSP430 GCC Optimization settings window.

![Figure 12. MSP430 GCC Settings: Optimization](image)

Table 6 describes the options that are available for MSP430 GCC Optimization settings.
### Table 6. MSP430 GCC Settings: Optimization

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Optimization Level</strong></td>
<td>Specifies the optimizations that the compiler applies to the generated object code. The options available are:</td>
</tr>
<tr>
<td></td>
<td>• None (O0): Disable optimizations. This setting is equivalent to specifying the -O0 command-line option. The compiler generates unoptimized linear assembly language code.</td>
</tr>
<tr>
<td></td>
<td>• Optimize (O1): The compiler performs all targets independent (that is, nonparallelized) optimizations, such as function inlining. This setting is equivalent to specifying the -O1 command-line option. The compiler omits all target-specific optimizations and generates linear assembly language code.</td>
</tr>
<tr>
<td></td>
<td>• Optimize more (O2): The compiler performs all optimizations (both target-independent and target-specific). This setting is equivalent to specifying the -O2 command-line option. The compiler outputs optimized nonlinear parallelized assembly language code.</td>
</tr>
<tr>
<td></td>
<td>• Optimize most (O3): The compiler performs all the level 2 optimizations, then the low-level optimizer performs global-algorithm register allocation. This setting is equivalent to specifying the -O3 command-line option. At this optimization level, the compiler generates code that is usually faster than the code generated from level 2 optimizations.</td>
</tr>
<tr>
<td><strong>Optimize for speed disregarding exact standards compliance (-Ofast)</strong></td>
<td>Disregard strict standards compliance. -Ofast enables all -O3 optimizations. It also enables optimizations that are not valid for all standard-compliant programs. It turns on -ffast-math and the Fortran-specific -fno-protect-parens and -fstack-arrays.</td>
</tr>
<tr>
<td><strong>Optimize for space rather than speed (-Os)</strong></td>
<td>Optimize for size (-Os) -Os enables all -O2 optimizations that do not typically increase code size. It also performs further optimizations designed to reduce code size. This setting is equivalent to specifying the -Os command-line option.</td>
</tr>
<tr>
<td><strong>Make ‘char’ unsigned by default (-funsigned-char)</strong></td>
<td>Enable this option to ensure that the char is signed.</td>
</tr>
<tr>
<td><strong>Place each function into its own section (-ffunction-sections)</strong></td>
<td>Enable this option to use function sections and is equivalent to -ffunction-sections.</td>
</tr>
<tr>
<td><strong>Place data items into their own section (-fdata-sections)</strong></td>
<td>Enable this option to use short data sections and is equivalent to -ffunction-sections.</td>
</tr>
<tr>
<td><strong>Convert floating point constants to single precision constants</strong></td>
<td>Treat floating-point constants as single precision instead of implicitly converting them to double-precision constants.</td>
</tr>
</tbody>
</table>
### GNU Compiler: Preprocessor

Figure 13 shows the MSP430 GCC Preprocessor settings window.

![MSP430 GCC Settings: Preprocessor](image)

**Figure 13. MSP430 GCC Settings: Preprocessor**

Table 7 describes the options that are available for MSP430 GCC Preprocessor settings.

#### Table 7. MSP430 GCC Settings: Preprocessor

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Preprocess only; do not compile, assemble or link (-E)</td>
<td>Enable this option to preprocess only without compiling or assembling or linking.</td>
</tr>
<tr>
<td>Other preprocessor flags (-Xpreprocessor)</td>
<td>Use this to supply system-specific preprocessor options that GCC does not recognize.</td>
</tr>
<tr>
<td></td>
<td>To pass an option that takes an argument, use -Xpreprocessor twice, once for the option and</td>
</tr>
<tr>
<td></td>
<td>once for the argument.</td>
</tr>
</tbody>
</table>
3.3.7 GNU Compiler: Assembler

Figure 14 shows the MSP430 GCC Assembler settings window.

![Figure 14. MSP430 GCC Settings: Assembler](image)

Table 8 describes the options that are available for MSP430 GCC Assembler settings.

**Table 8. MSP430 GCC Settings: Assembler**

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Other assembler flags (-Xassembler)</td>
<td>Specifies individual flag based on the user requirements.</td>
</tr>
</tbody>
</table>
3.3.8 GNU Compiler: Debugging

Figure 15 shows the MSP430 GCC Debugging settings window.

![Figure 15. MSP430 GCC Settings: Debugging](image)

Table 9 describes the options that are available for MSP430 GCC Debugging settings.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Generate debug information (-g)</td>
<td>Produce debugging information. This information is required by the GDB debugger.</td>
</tr>
<tr>
<td>Generate debug information in DWARF version (-gdwarf-)</td>
<td>Produce debugging information in DWARF format (if that is supported). The value of version may be 2, 3 or 4; the default version for most targets is 4.</td>
</tr>
<tr>
<td>Do not emit DWARF additions beyond selected version (-gstrict-dwarf)</td>
<td>Disallow using extensions of later DWARF standard version than selected with -gdwarf-version. On most targets using nonconflicting DWARF extensions from later standard versions is allowed.</td>
</tr>
<tr>
<td>Enable function profiling (-p)</td>
<td>Generate extra code to write profile information suitable for the analysis program. This option is required when compiling source files for which data is needed, and it is also required when linking.</td>
</tr>
</tbody>
</table>
3.3.9 GNU Compiler: Diagnostic Options

Figure 16 shows the MSP430 GCC Diagnostic Options settings window.

![MSP430 GCC Settings: Diagnostic Options](image)

**Figure 16. MSP430 GCC Settings: Diagnostic Options**

Table 10 describes the options that are available for MSP430 GCC Diagnostic Options settings.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Check for syntax errors, then stop (-fsyntax-only)</td>
<td>Enable this option to check the syntax of the code and report any errors.</td>
</tr>
<tr>
<td>Suppress warnings (-w)</td>
<td>Inhibit all warning messages.</td>
</tr>
<tr>
<td>Enable most warning messages (-Wall)</td>
<td>Enable this option to enable all the warnings about constructions that some users consider questionable, and that are easy to avoid (or modify to prevent the warning), even in conjunction with macros.</td>
</tr>
<tr>
<td>Treat all warnings as errors (-Werror)</td>
<td>Enable this option to make all warnings into hard errors. Source code that triggers warnings is rejected.</td>
</tr>
<tr>
<td>Enable verbose output (-v)</td>
<td>Enable this option for the IDE to show each command line that it passes to the shell, along with all progress, error, warning, and informational messages that the tools emits. This setting is equivalent to specifying the --v command-line option. By default, this checkbox is clear. The IDE displays only error messages that the compiler emits. The IDE suppresses warning and informational messages.</td>
</tr>
</tbody>
</table>
3.3.10 GNU Compiler: Miscellaneous

Figure 17 shows the MSP430 GCC Miscellaneous settings window.

Table 11 describes the options that are available for MSP430 GCC Miscellaneous settings.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Override built-in specs with the contents of the specified file (-specs)</td>
<td>The spec strings built into GCC can be overridden by using the -specs= command-line switch to specify a spec file.</td>
</tr>
<tr>
<td>Other flags</td>
<td>-mlarge&lt;br&gt;-mcode-region=none&lt;br&gt;-mdata-region=none&lt;br&gt;&lt;br&gt;The MSP430 compiler has the ability to automatically distribute code and data between low memory (addresses below 64K) and high memory. This only applies to parts that actually have both memory regions and only if the linker script for the part has been specifically set up to support this feature. See Table 21 for more information.</td>
</tr>
</tbody>
</table>
3.3.11  GNU Linker

Figure 18 shows the MSP430 GCC Linker settings window.

Table 12 describes the options that are available for MSP430 GCC Linker settings.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Command</td>
<td>Linker location</td>
</tr>
<tr>
<td>Command-line pattern</td>
<td>Command line parameters</td>
</tr>
<tr>
<td>Summary of flags set</td>
<td>Command line with which the compiler is called. Displays all the flags passed to the linker.</td>
</tr>
</tbody>
</table>
3.3.12 GNU Linker: Basic

Figure 19 shows the MSP430 GCC Linker Basic settings window.

Table 13 describes the options that are available for MSP430 GCC Linker Basic settings.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Output file (-o)</td>
<td><code>-o output</code> Use output as the name for the file produced by ld; if this option is not specified, the name 'a.out' is used by default. The script command OUTPUT can also specify the output file name.</td>
</tr>
<tr>
<td>Write a map file (-Map)</td>
<td>Print to the file mapfile a link map, which contains diagnostic information about where symbols are mapped by ld and information on global common storage allocation.</td>
</tr>
<tr>
<td>Set start address (-e, --entry)</td>
<td>Use entry as the explicit symbol for beginning execution of the program, rather than the default entry point.</td>
</tr>
<tr>
<td>Do not use the standard system startup files when linking (-nostartfiles)</td>
<td>Do not use the standard system startup files when linking. The standard system libraries are used unless -nostdlib or -nodefaultlibs is used.</td>
</tr>
</tbody>
</table>
### Table 13. MSP430 GCC Linker Basic Settings (continued)

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Do not use the standard system libraries when linking (-nodefaultlibs)</td>
<td>Do not use the standard system libraries when linking. Only the specified libraries are passed to the linker, and options specifying linkage of the system libraries, such as -static-libgcc or -shared-libgcc, are ignored. The standard startup files are used unless -nostartfiles is used. The compiler may generate calls to memcmp, memset, memcpy, and memmove. These entries are usually resolved by entries in libc. These entry points should be supplied through some other mechanism when this option is specified.</td>
</tr>
<tr>
<td>Do not use the standard system startup files or libraries when linking (-nostdlib)</td>
<td>Do not use the standard system startup files or libraries when linking.</td>
</tr>
<tr>
<td>Do not link with the shared libraries (-static)</td>
<td>On systems that support dynamic linking, this prevents linking with the shared libraries. On other systems, this option has no effect.</td>
</tr>
<tr>
<td>Remove unused sections (--gc-sections)</td>
<td>Enable garbage collection of unused input sections. It is ignored on targets that do not support this option.</td>
</tr>
</tbody>
</table>

#### 3.3.13 GNU Linker: Libraries

Figure 20 shows the MSP430 GCC Linker Libraries settings window.

![MSP430 GCC Linker Libraries Settings](image)

**Figure 20. MSP430 GCC Linker Libraries Settings**
Table 14 describes the options that are available for MSP430 GCC Linker Libraries settings.

Table 14. MSP430 GCC Linker Libraries Settings

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
</table>
| Linker command files (-T, --script) | -T commandfile  
Read link commands from the file command file. |
| Libraries (-l, --library)           | -l library  
Search the library named library when linking. |
| Library search path (-L, --library-path) | -L searchdir  
Add path searchdir to the list of paths that ld will search for archive libraries and ld control scripts. |

3.3.14 GNU Linker: Symbols

Figure 21 shows the MSP430 GCC Linker Symbols settings window.

Figure 21. MSP430 GCC Linker Symbols Settings
Table 15 describes the options that are available for MSP430 GCC Linker Symbols settings.

### Table 15. MSP430 GCC Linker Symbols Settings

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Define a symbol (--defsym)</td>
<td><code>-defsym symbol=expression</code></td>
</tr>
<tr>
<td>Start with undefined reference to SYMBOL</td>
<td><code>-undefined, -u</code></td>
</tr>
<tr>
<td></td>
<td>Force symbol to be entered in the output file as an undefined symbol</td>
</tr>
</tbody>
</table>

3.3.15 GNU Linker: Miscellaneous

Figure 22 shows the MSP430 GCC Linker Miscellaneous settings window.

Table 16 describes the options that are available for MSP430 GCC Linker Miscellaneous settings.

### Table 16. MSP430 GCC Linker Miscellaneous Settings

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Other flags</td>
<td>Specifies individual flags based on the user requirements.</td>
</tr>
</tbody>
</table>
3.3.16 GNU Objcopy Utility

Figure 23 shows the MSP430 GCC GNU Objcopy Utility settings window.

![GNU Objcopy Utility Settings Window](image)

Figure 23. MSP430 GCC GNU Objcopy Utility Settings

Table 17 describes the options that are available for GNU Objcopy Utility.

Table 17. MSP430 GCC GNU Objcopy Utility Settings

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Enable GNU Objcopy Utility</td>
<td>Enable this option to enable the GNU Objcopy Utility. It is disabled by default.</td>
</tr>
<tr>
<td>Command</td>
<td>GNU Objcopy location</td>
</tr>
<tr>
<td>Command-line pattern</td>
<td>Command line parameters</td>
</tr>
<tr>
<td>Summary of flags set</td>
<td>Command line with which the GNU Objcopy is called. Displays all the flags passed to the Objcopy command.</td>
</tr>
</tbody>
</table>
Figure 24 shows the MSP430 GCC GNU Objcopy Utility General Options settings window.

Figure 24. MSP430 GCC GNU Objcopy Utility General Options Settings

Table 18 describes the options that are available for GNU Objcopy Utility General Options.

Table 18. MSP430 GCC GNU Objcopy Utility General Options Settings

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Specify output file name</td>
<td>Specifies the output file name</td>
</tr>
<tr>
<td>Assume input file is in format &lt;bfdname&gt;</td>
<td>-I bfdname Consider the source file’s object format to be bfdname, rather</td>
</tr>
<tr>
<td>(-I, --input-target)</td>
<td>than attempting to deduce it.</td>
</tr>
<tr>
<td>Create an output file in format &lt;bfdname&gt;</td>
<td>-O bfdname Write the output file using the object format bfdname.</td>
</tr>
<tr>
<td>(-O, --output-target)</td>
<td></td>
</tr>
<tr>
<td>Set output arch, when input is arch-less</td>
<td>-B bfdarch Useful when transforming an architecture-less input file into</td>
</tr>
<tr>
<td>(-B, --binary-architecture)</td>
<td>an object file. In this case the output architecture can be set to bfdarch.</td>
</tr>
<tr>
<td>Convert debugging information, if possible</td>
<td>Convert debugging information, if possible. This is not the default</td>
</tr>
<tr>
<td>(--debugging)</td>
<td>because only certain debugging formats are supported, and the conversion</td>
</tr>
<tr>
<td>Copy modified/access timestamps to the output</td>
<td>Set the access and modification dates of the output file to be the same</td>
</tr>
<tr>
<td>(-p, --preserve-dates)</td>
<td>as those of the input file.</td>
</tr>
</tbody>
</table>
### Table 18. MSP430 GCC GNU Objcopy Utility General Options Settings (continued)

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Remove section <code>&lt;name&gt;</code> from the output</td>
<td><code>-R sectionpattern</code>&lt;br&gt;<code>--remove-section=sectionpattern</code> Remove any section matching sectionpattern from the output file. This option may be given more than once. Note that using this option inappropriately may make the output file unusable. Wildcard characters are accepted in sectionpattern. Using the <code>-j</code> and <code>-R</code> options together results in undefined behavior.</td>
</tr>
<tr>
<td>Remove all symbol and relocation information (<code>-S</code>, <code>--strip-all</code>)</td>
<td>Do not copy relocation and symbol information from the source file.</td>
</tr>
<tr>
<td>Remove all debugging symbols sections (<code>-g</code>, <code>--strip-debug</code>)</td>
<td>Do not copy debugging symbols or sections from the source file.</td>
</tr>
<tr>
<td>Remove all symbols not needed by relocations (<code>-strip-unneeded</code>)</td>
<td>Strip all symbols that are not needed for relocation processing.</td>
</tr>
<tr>
<td>Set the start address to <code>&lt;addr&gt;</code> (<code>-set-start</code>)</td>
<td>Set the start address of the new file to the specified value. Not all object file formats support setting the start address.</td>
</tr>
<tr>
<td>List all object files modified (<code>-v</code>, <code>--verbose</code>)</td>
<td>Verbose output: list all object files modified. In the case of archives, <code>objcopy -V</code> lists all members of the archive.</td>
</tr>
</tbody>
</table>

Figure 25 shows the MSP430 GCC GNU Objcopy Utility Miscellaneous settings window.

![Figure 25: MSP430 GCC GNU Objcopy Utility Miscellaneous settings window](image-url)
Table 19 describes the options that are available for GNU Objcopy Utility Miscellaneous.

Table 19. MSP430 GCC GNU Objcopy Utility Miscellaneous Settings

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Other flags</td>
<td>Specifies individual flags based on the user requirements.</td>
</tr>
</tbody>
</table>

3.4 Change an Existing CCS project That Uses TI Compiler to MSP430 GCC

An existing CCS project that uses the TI compiler can be changed to use MSP430 GCC. Refer to Using MSP430-GCC with CCSv6 for more details.

3.5 Create a New CDT Project Using MSP430 GCC

A standard Eclipse C/C++ project (rather than a CCS project) can use the MSP430 GCC compiler. This would be necessary if you want to debug using GDB instead of the CCS debugger.

To create a new Eclipse C/C++ project that uses MSP430 GCC tools to build the executable, refer to Using MSP430-GCC with CCSv6.

3.6 GDB With MSP430 and CCSv6

CCSv6 and later can use GDB to debug MSP430 devices. To use the CCS GUI for things like setting and removing breakpoints, the project should be an Eclipse C/C++ project rather than a CCS project.

Refer to GDB with MSP430 and CCSv6 for more details.

3.7 CCS Compared to MSP430 GCC

Some CCS features are not supported in MSP430 GCC. These features are:

- Optimizer Assistant
- ULP Advisor
- Memory Protection Unit and Intellectual Property Encapsulation GUI configuration
- Memory allocation

To gain access to these features, the TI Compiler must be used.

4 MSP430 GCC Stand-Alone Package

4.1 MSP430 GCC Stand-Alone Packages

The MSP430 GCC stand-alone package is provided for users who prefer to use the MSP430 GCC compiler with other IDE or console-based solutions for compiling and debugging. This stand-alone package supports different operating systems and is provided in different formats:

- GCC and GDB binaries for Windows, Linux, and OS X
- MSP430 header and linker files
- MSP430 GCC source code
- GBD agent configuration
Table 20 lists all the available MSP430 GCC stand-alone packages.

### Table 20. MSP430 GCC Stand-Alone Package

<table>
<thead>
<tr>
<th>Software</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>msp430-gcc-full-linux-installer-x.x.x.x.run</td>
<td>MSP430 GCC Linux installer including support files and debug stack and USB drivers. Apply <code>sudo chmod +x &lt;installer&gt;</code> before executing the package</td>
</tr>
<tr>
<td>msp430-gcc-full-windows-installer- x.x.x.x.exe</td>
<td>MSP430 GCC Windows installer including support files and debug stack and USB drivers</td>
</tr>
<tr>
<td>msp430-gcc-full-mac-installer- x.x.x.x.app</td>
<td>MSP430 GCC OS X installer including support files and debug stack and USB drivers</td>
</tr>
<tr>
<td>msp430-gcc-linux-installer- x.x.x.x.run</td>
<td>MSP430 GCC Linux installer. Compiler only. Apply <code>sudo chmod +x &lt;installer&gt;</code> before executing the package</td>
</tr>
<tr>
<td>msp430-gcc-windows-installer- x.x.x.x.exe</td>
<td>MSP430 GCC Windows installer. Compiler only.</td>
</tr>
<tr>
<td>msp430-gcc-mac-installer- x.x.x.x.app</td>
<td>MSP430 GCC OS X installer. Compiler only.</td>
</tr>
<tr>
<td>msp430-gcc-support-files.zip</td>
<td>Header files</td>
</tr>
<tr>
<td>msp430-gcc-source.tar.bz2</td>
<td>MSP430 GCC source files</td>
</tr>
<tr>
<td>md5sum.txt</td>
<td>MD5 checksums</td>
</tr>
</tbody>
</table>

### 4.1.1 MSP430 GCC Stand-Alone Package Folder Structure

The placeholder INSTALL_DIR refers to the directory where you installed the GCC MSP430 package.

- INSTALL_DIR
  - bin
    - MSP430 GCC Compiler binary
    - GDB binary
    - binutils
    - Tcl
    - GDB Agent
    - MSP430 Debug Stack
  - common
  - docs
  - emulation
    - Windows USB-FET Drivers
  - examples
  - include
    - MSP430 Support Files
  - lib
  - libexec
  - msp430-elf
    - lib
      - libatomic
      - libcgc
      - libssp
      - libstdC++-v3
      - libbacktrace
      - libgcc-math
      - libgloss
      - libiberty
4.2 Package Content

MSP430 GCC contains binary and sources software development tools for all TI MSP430 devices. The toolchain contains: compiler, assembler, linker, debugger, libraries, and other utilities.

These software development tools include:

- Compiler: MSP430 GCC (**msp430-elf-gcc**) is configured to compile C or C++.
- Binutils: assembler, archiver, linker, librarian, and other programs.
- Newlib is the standard C library.
- Debugging: gdb_agent_console.exe and gdb_agent_gui.exe

4.3 MSP430 GCC Options

The MSP430 GCC toolchain supports the following options in addition to the standard GCC options:

- **-msim**
- **-masm-hex**
- **-mmcu=**
- **-mcpu=**
- **-mlarge**
- **-msmall**
- **-mrelax**
- **-mhwmult=**
- **-mwarn-mcu=**
- **-mno-warn-mcu=**
- **-minrt**
- **-mcode-region=**
- **-mdata-region=**
- **-msilicon-errata=**
- **-msilicon-errata-warn=**

For the most up-to-date information, refer to the GCC online documentation.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>-masm-hex</td>
<td>Force assembly output to always use hex constants. Normally such constants are signed decimals, but this option is available for test suite or aesthetic purposes.</td>
</tr>
<tr>
<td>-mmcu=</td>
<td>Select the MCU to target. This is used to create a C preprocessor symbol based upon the MCU name, converted to upper case and prefixed and postfixed with '__'. This in turn is used by the 'msp430.h' header file to select an MCU-specific supplementary header file. The option also sets the ISA to use. If the MCU name is one that is known to only support the 430 ISA then that is selected, otherwise the 430X ISA is selected. A generic MCU name of 'msp430' can also be used to select the 430 ISA. Similarly, the generic 'msp430x' MCU name selects the 430X ISA. In addition an MCU-specific linker script is added to the linker command line. The script's name is the name of the MCU with '.ld' appended. Thus specifying '-mmcu=xxx' on the gcc command line defines the C preprocessor symbol <strong>XXX</strong> and cause the linker to search for a script called 'xxx.ld'. This option is also passed on to the assembler.</td>
</tr>
<tr>
<td>-mcpu=</td>
<td>Specifies the ISA to use. Accepted values are 'msp430', 'msp430x' and 'msp430xv2'. This option is deprecated. The '-mmcu=' option should be used to select the ISA.</td>
</tr>
<tr>
<td>-msim</td>
<td>Link to the simulator runtime libraries and linker script. Overrides any scripts that would be selected by the '-mmcu=' option.</td>
</tr>
<tr>
<td>-mlarge</td>
<td>Use large-model addressing (20-bit pointers, 32-bit size_t).</td>
</tr>
<tr>
<td>-msmall</td>
<td>Use small-model addressing (16-bit pointers, 16-bit size_t).</td>
</tr>
<tr>
<td>-mrelax</td>
<td>This option is passed to the assembler and linker, and allows the linker to perform certain optimizations that cannot be done until the final link.</td>
</tr>
</tbody>
</table>
Table 21. MSP430 GCC Command Options (continued)

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>-mhwmult=</td>
<td>Describes the type of hardware multiply supported by the target. Accepted values:</td>
</tr>
<tr>
<td></td>
<td>• 'none' for no hardware multiply</td>
</tr>
<tr>
<td></td>
<td>• '16bit' for the original 16-bit-only multiply supported by early MCUs</td>
</tr>
<tr>
<td></td>
<td>• '32bit' for the 16/32-bit multiply supported by later MCUs</td>
</tr>
<tr>
<td></td>
<td>• 'f5series' for the 16/32-bit multiply supported by F5-series MCUs.</td>
</tr>
<tr>
<td></td>
<td>• 'auto' can also be given. This tells GCC to deduce the hardware multiply support based on the MCU name provided by the '-mmcu' option.</td>
</tr>
<tr>
<td></td>
<td>If no '-mmcu' option is specified, then '32bit' hardware multiply support is assumed. 'auto' is the default setting.</td>
</tr>
<tr>
<td></td>
<td>Hardware multiplies are normally performed by calling a library routine. This saves space in the generated code. When compiling at '-O3' or higher, however, the hardware multiplier is invoked inline. This makes for larger but faster code.</td>
</tr>
<tr>
<td></td>
<td>The hardware multiply routines disable interrupts while running and restore the previous interrupt state when they finish. This makes them safe to use inside interrupt handlers as well as in normal code.</td>
</tr>
<tr>
<td>-minrt</td>
<td>Enable the use of a minimum runtime environment (no static initializers or constructors). This is intended for memory-constrained devices. The compiler includes special symbols in some objects that tell the linker and runtime which code fragments are required.</td>
</tr>
<tr>
<td>-mcode-region=</td>
<td>These options tell the compiler where to place functions and data that do not have one of the lower, upper, either or section attributes. Possible values are:</td>
</tr>
<tr>
<td>-mdata-region=</td>
<td>• lower</td>
</tr>
<tr>
<td></td>
<td>• upper</td>
</tr>
<tr>
<td></td>
<td>• either</td>
</tr>
<tr>
<td></td>
<td>• any</td>
</tr>
<tr>
<td></td>
<td>The first three behave like the corresponding attribute. The fourth possible value ('any') is the default. It leaves placement entirely up to the linker script and how it assigns the standard sections (.text, .data, and so on) to the memory regions.</td>
</tr>
<tr>
<td>-msilicon-errata=</td>
<td>Implements fixes for named silicon errata. Multiple silicon errata can be specified by multiple uses of the -msilicon-errata option or by including the errata names, separated by commas, on an individual -msilicon-errata option. Errata names currently recognized by the assembler are:</td>
</tr>
<tr>
<td>NAME[,NAME...]</td>
<td>cpu4 = PUSH #4 and PUSH #8 need longer encodings on the MSP430. This option is enabled by default, and cannot be disabled.</td>
</tr>
<tr>
<td></td>
<td>cpu8 = Do not set the SP to an odd value.</td>
</tr>
<tr>
<td></td>
<td>cpu11 = Do not update the SR and the PC in the same instruction.</td>
</tr>
<tr>
<td></td>
<td>cpu12 = Do not use the PC in a CMP or BIT instruction.</td>
</tr>
<tr>
<td></td>
<td>cpu13 = Do not use an arithmetic instruction to modify the SR.</td>
</tr>
<tr>
<td></td>
<td>cpu19 = Insert NOP after CPUOFF.</td>
</tr>
<tr>
<td>-msilicon-errata-</td>
<td>Like the -msilicon-errata option, except that instead of fixing the specified errata, a warning message is issued instead. This option can be used with -msilicon-errata to generate messages whenever a problem is fixed, or on its own to inspect code for potential problems.</td>
</tr>
<tr>
<td>warn=NAME[,NAME...]</td>
<td></td>
</tr>
</tbody>
</table>

4.4 MSP430 Built-in Functions

GCC provides special built-in functions to aid in the writing of interrupt handlers in C.

__bic_SR_register_on_exit (int mask)__

This clears the indicated bits in the saved copy of the status register that currently resides on the stack. This only works inside interrupt handlers and the changes to the status register only take effect after the handler returns.

__bis_SR_register_on_exit (int mask)__

This sets the indicated bits in the saved copy of the status register that currently resides on the stack. This only works inside interrupt handlers and the changes to the status register only take effect after the handler returns.
4.5 **MSP430 GCC Interrupts Definition**

To define an interrupt using MSP430 GCC, use the following syntax:

```c
void __attribute__((interrupt(INTERRUPT_VECTOR))) INTERRUPT_ISR (void)
```

The "static" keyword should not be used on ISR definition.

**Code Example:**

```
void __attribute__((interrupt(UNMI_VECTOR))) UNMI_ISR (void)
{
    // isr
}
```

You could also use the macro defined in the iomacros.h file:

```
#define __interrupt_vec(vec)__attribute__((interrupt(vec))
```

**Example:**

```
void __interrupt_vec(UNMI_VECTOR) UNMI_ISR (void)
{
}
```

4.6 **Quick Start: Blink the LED**

This document assumes that a version of the GNU Make utility is installed on the system and that it is available on the system path. The placeholder INSTALL_DIR refers to the directory where the GCC MSP430 package is installed. The directory INSTALL_DIR/bin should be on the system path.

4.6.1 **Building With a Makefile**

1. In the command terminal, go to the INSTALL_DIR/examples directory.
2. There are examples for Windows and Linux. They are located in the corresponding subdirectories. Choose one of the examples suitable for the operating system and MSP430 target device.
3. Change to the directory and type `make`.
4. The binary can now be downloaded and debugged on the target hardware.

4.6.2 **Building Manually With gcc**

To build one of the examples manually, open a terminal and change to the example suitable for the target device and operating system. The compiler executable `msp430-elf-gcc` must be available on your system path.

```
msp430-elf-gcc -I <Path to MSP430 Support Files> -L <Path to MSP430 Support Files> -T DEVICE.ld -mmcu=DEVICE -O2 -g blink.c -o blink.o
```

The placeholder `<Path to MSP430 Support Files>` is the directory that contains the MSP430 support files (header files and linker scripts to support the different MSP430 devices).

The placeholder DEVICE tells the compiler and linker to create code for the target device. The command line argument `-T DEVICE.ld` is optional, as the compiler automatically selects the correct linker script from the `-mmcu=DEVICE` argument.

**Example**

```
msp430-elf-gcc -I=../../../include -L=../../../include -T msp430fr5969.ld -mmcu=msp430fr5969 -O2 -g blink.c -o blink.o
```
4.6.3 Debugging

4.6.3.1 Starting GDB Agent
On Microsoft Windows, the GDB Agent is available as either as a small GUI application or on the command line. On GNU Linux, only the command line version is available.

4.6.3.1.1 Using the GUI
Open the INSTALL_DIR/bin directory and double-click gdb_agent_gui.
1. After the program starts, click the button Configure, select msp430.dat, and click Open.
2. Click on the button Start under the Panel Controls.
3. The "Log" window now contains the status message "Waiting for client".
4. Leave the window open until the end of the debugging process.

4.6.3.1.2 Using the Command Line
Open a command terminal, change to INSTALL_DIR and type:

Linux
./bin/gdb_agent_console msp430.dat

Windows
\bin\gdb_agent_console msp430.dat

4.6.3.2 Debugging With GDB

4.6.3.2.1 Running a Program in the Debugger
1. In the command terminal, go to the INSTALL_DIR\examples\[Selected example], and type the command make debug.
2. This command starts the GDB and waits for commands. This is indicated by the prompt <gdb>.
3. To connect GDB to the GDB Agent, type the command target remote :55000 and press enter.
4. To load the program binary to the MSP430 target device, type load.
5. Type the command continue (short version: c) to tell GDB to run the loaded program.
6. The LED on the target board blinks.

4.6.3.2.2 Setting a Breakpoint
1. Connect the GDB to the GDB Agent as previously described and load a program to the device.
2. To set a breakpoint on a function, type break function name.
3. To set a breakpoint on a source line, type break filename:line.
4. When you run the program, the program execution stops at the entry to the specified function or stops at the specified line.

4.6.3.2.3 Single Stepping
1. Connect the GDB to the GDB Agent as previously described and load a program to the device.
2. After the debugger has stopped the program at a breakpoint, you can step through the code:
   (a) To execute the source line, type next. next does not step into functions, it executes the complete function and stops on the line following the function call.
   (b) To execute the next source line and step into functions, type step.
   (c) To execute the next instruction, type nexti.
   (d) To execute the next instruction and step into functions, type stepi.
4.6.3.2.4 Stopping or Interrupting a Running Program

1. Connect the GDB to the GDB Agent as previously described and load a program to the device.
2. To stop a running program and get back to the GDB command prompt, type Ctrl+C. This currently applies only on Linux.

4.6.4 Creating a New Project

1. Create a directory for your project.
2. Copy one of the example project makefiles into the project directory.
3. Open the copied makefile and set the variable DEVICE to the target device.
4. Set the variable GCC_DIR to point to the directory where the GCC MSP430 package is installed.
5. Include all of the project source files (that is, the *.c files) as a dependency for the first target of the makefile.
6. Go to the project directory in a terminal and type make to build the project or make debug to start debugging the project.

```
OBJECTS=blink.o

GCC_DIR = ../../bin
SUPPORT_FILE_DIRECTORY = ../../include

# Please set your device here
DEVICE = msp430X
CC = $(GCC_DIR)/msp430-elf-gcc
GDB = $(GCC_DIR)/msp430-elf-gdb

CFLAGS = -I $(SUPPORT_FILE_DIRECTORY) -mmcu=$(DEVICE) -O2 -g
LFLAGS = -L $(SUPPORT_FILE_DIRECTORY) -T $(DEVICE).ld

all: $(OBJECTS)
    $(CC) $(CFLAGS) $(LFLAGS) $? -o $(DEVICE).out

debuge: all
    $(GDB) $(DEVICE).out
```

4.7 GDB Settings

The GDB Agent is a tool to connect the GDB with the target hardware to debug software. The GDB Agent uses the MSP430 debug stack to connect to the hardware and provides an interface to the GDB. On Windows, both a console and a GUI application version of the GDB agent are provided. Only the console application is supported on Linux.

4.7.1 Console Application

If you use the console application, invoke it from a command terminal using following syntax:

Linux
```
INSTALL_DIR/bin/gdb_agent_console INSTALL_DIR/msp430.dat
```

Windows
```
INSTALL_DIR\bin\gdb_agent_console INSTALL_DIR\msp430.dat
```

The console application opens a TCP/IP port on the local machine. It displays the port number in the console. By default, this port number is 55000.
4.7.2 GUI Application

After you start the GUI application, configure the GUI and then start the GDB server. For more information, refer to the XDS GDB Agent online documentation.

1. Click the Configure button and, in the Select board configuration file window, select the msp430.dat file. If successfully configured, an MSP430 device is displayed in the <Targets> list. The TCP/IP port for the GDB server is displayed when the MSP430 device is selected from the list.

2. To start the GDB Agent, click the Start button when the MSP430 device is selected.

4.7.3 Attaching the Debugger

After starting the debugger and to attach to the GDB server, use the target remote [<host ip address>]:<port> command, where <port> is the TCP/IP port from above. If the GDB Agent runs locally, omit the host IP address.

4.7.4 Configuring the Target Voltage

To configure the target voltage for the device, open the file msp430.dat in a text editor. To change the voltage, modify the key msp430_vcc. By default, this value is set to 3.3 V.

4.7.5 Resetting the Target

To reset the target, use the monitor reset command.

4.7.6 Halting the Target

To halt the target, use the monitor halt command.

5 Building MSP430 GCC From Sources

5.1 Required Tools

This document assumes that the required tools are installed on the system and that they are available on the system path.

- GNU make
- GCC and binutils
- bzip2 and tar

5.2 Building MSP430 GCC (Somnium)

Follow these steps to build Somnium MSP430 GCC:

1. Download the tar source file (for example, msp430-gcc-5.3.0.216_source-full.tar.bz2) from the MSP430 GCC page.
2. Untar the file.
3. Change to the source-full directory.
4. Run the bash script in README.sh.
5. Build files are in the ./build folder.
6. Binaries/libs are in the ./install folder.

---

NOTE: An alternative to this process is to use the following "source-patches" tar file to apply patches to source tars as released by the upstream community:
msp430-gcc-5.3.0.216_source-patches.tar.bz2
5.3 Building MSP430 GCC (Red Hat)

NOTE: The following Linux and Windows builds are from Linux (cross compile Windows). The OS X builds are native.

Make sure that LIBRARY_PATH is set correctly.

The building steps for Linux, Windows, and OS X (see Section 5.3.1, Section 5.3.2, and Section 5.3.3, respectively) are similar to each other.

1. Download and extract the MSP430 GCC sources from TI website.
2. `export`: Export all needed variables
3. `mkdir build`: Create a build directory
4. `cd build`: Change to build directory
5. `../sources/tools/configure`: Configure the entire GCC sources directory before the build. See the corresponding options for every build below.
6. `make all`: Compile the entire program.
7. `make install`: Copy the executables, libraries, and so on to the file names where they should reside for actual use.
8. `make info`: Generate Compile Info files.
9. `make install-info`: Generate install Info files.

NOTE:
1. MSP430 GCC must always build in a separate (empty) directory.
2. Make sure that you have all the required packages in your system (libgmp, libmpfr, zlib, tcl, tk, itlc).

5.3.1 Building MSP430 GCC on Linux

```
% tar xvjf msp430-gcc-source.tar.bz2?tracked=1
% mkdir build
% cd build
% ../sources/tools/configure --prefix=/path/to/install_location --target=msp430-elf --enable_languages=c,c++
% make all
% make install
% make info
% make install-info
```

5.3.2 Building MSP430 GCC on Windows (Cross Compiled on Linux)

```
% tar xvjf msp430-gcc-source.tar.bz2?tracked=1
% yum install mingw32-gcc mingw32-gcc-g++
Configm win32 gcc:
% ls -l /usr/bin/*gcc
/usr/bin/gcc
/usr/bin/i386-redhat-linux-gcc
/usr/bin/i686-pc-mingw32-gcc
% export PATH=/path/to/install_location/bin:$PATH
```
Building MSP430 GCC From Sources

% mkdir build
% cd build

From above yum install, the "i686-pc-mingw32" matches --
host below. You must have a pre-built msp430-elf native toolchain in your $PATH:

% ../sources/tools/configure --prefix=/path/to/install_location --target=msp430-elf --
enable-languages=c,c++ --host=i686-pc-mingw32 --disable-itcl --disable-tk --disable-
tcl --disable-libgui --disable-gdbtk
% make all
% make install
% make info
% make install-info

5.3.3 Building MSP430 GCC on OS X

% wget http://software-
dl.ti.com/msp430/msp430_public_sw/mcu/msp430/MSPGCC/latest/exports/msp430-gcc-
source.tar.bz2% tar xvjf msp430-gcc-source.tar.bz2?tracked=1

% export PATH=/usr/local/bin:/usr/bin:/bin:/usr/local/sbin:/usr/sbin:/sbin
% export LIBRARY_PATH=/usr/X11/lib
% export MACOSX_DEPLOYMENT_TARGET=10.5
% mkdir build% cd build% ../sources/tools/configure --target=msp430-elf --
prefix=/path/to/install_location --enable-languages=c,c++ --disable-werror --disable-
itcl --disable-tk --disable-tcl --disable-libgui --disable-gdbtk --disable-sim
% make all
% make install
% make info
% make install-info

5.4 Building MSP430 GCC Stand-Alone Full Package

1. MSP430 GCC Compiler
   (a) Download the MSP430 GCC Installer Compiler only from http://www.ti.com/tool/msp430-gcc-
   opensource.
   (b) Use the generated MSP430 GCC version (see Section 5.3).

2. USB driver package (Windows only)
   (a) Download "Stand-alone Driver Installer for USB Low-Level Drivers" from

3. MSPDS OS package

4. Build MSPDebugStack
   (a) Extract "MSP Debug Stack Open Source Package".
   (b) Follow the instructions in "README-BUILD.txt".

5. GDB agent
   (a) Download the GDB agent from

6. MSP430 support files for GCC
   (a) Download "msp430-gcc-support-files.zip" from http://software-
6 MSP430 GCC and MSPGCC

The new GCC compiler for MSP low-power microcontrollers conforms to the MSP Embedded Application Binary Interface (EABI) (see MSP430 Embedded Application Binary Interface). This allows GCC to interoperate with the proprietary TI compiler.

For example, assembly functions can be written in the same way, and libraries that are built with one compiler can be used as part of executables built with the other compiler. Aligning with the MSP EABI required breaking compatibility with the prior MSPGCC compiler. This document gives a brief overview of the ABI changes that are most likely to be noticed by and to affect a developer who is moving from MSPGCC to the newer GCC compiler for MSP.

6.1 Calling Convention

For developers writing assembly code, the most noticeable part of an ABI is the calling convention. Full specification of the calling convention is very detailed (see MSP430 Embedded Application Binary Interface), but developers writing assembly do not typically use most of it. There are three basic differences between MSPGCC and the GCC compiler for MSP in the calling convention that are important to be aware of:

- In MSPGCC, registers are passed starting with R15 and descending to R12. For example, if two integers are passed, the first is passed in R15 and the second is passed in R14. In contrast, the MSP430 EABI specifies that arguments are passed beginning with R12 and moving up to R15. So, in the same situation, registers R12 and R13 would hold the two arguments. In both cases, after the registers R12 through R15 are used, continued arguments are passed on the stack. If you are using stack-based arguments, you should consult the EABI specification.

- MSPGCC and the GCC compiler for MSP use different registers for the return value. MSPGCC places the return value in R15 (or R15 and consecutive lower registers if the value is larger than a word), while the EABI specifies that the return value is placed in R12.

- In MSPGCC, register R11 is considered a save on entry register and needs to be saved and restored by the callee if it is used in the called function. Conversely, the MSP EABI specifies that R11 is a save on call register, so it needs to be saved and restored by the calling function if its value will be needed after a function call. For comparison purposes, R4 to R10 are save on entry registers for both compilers, and R12 to R15 are save on call.

These are the key differences to be aware of when moving between the compilers. If you are writing assembly code that passes parameters on the stack or that passes structures by value, you should consult the MSP EABI document for additional information.

6.2 Other Portions of the ABI

Many other pieces make up the EABI, such as the object file format; debug information, and relocation information that is used when linking together files. However, in general, these pieces do not affect migration.

One other area to be aware of is that the details of data layout differ between ABIs. If you are relying on advanced data layout details such as layout of structures and bitfields, see MSP430 Embedded Application Binary Interface.
7 Appendix

7.1 GCC Intrinsic Support

The GCC Compiler supports the same intrinsics that the TI CGT for MSP430 does. These are:

1. unsigned short __bcd_add_short(unsigned short op1, unsigned short op2);
2. unsigned long __bcd_add_long(unsigned long op1, unsigned long op2);
3. unsigned short __bic_SR_register(unsigned short mask); BIC mask, SR
4. unsigned short __bic_SR_register_on_exit(unsigned short mask);
5. unsigned short __bis_SR_register(unsigned short mask);
6. unsigned short __bis_SR_register_on_exit(unsigned short mask);
7. unsigned long __data16_read_addr(unsigned short addr);
8. void __data16_write_addr(unsigned short addr, unsigned long src);
9. unsigned char __data20_read_char(unsigned long addr);
10. unsigned long __data20_read_long(unsigned long addr);
11. unsigned short __data20_read_short(unsigned long addr);
12. void __data20_write_char(unsigned long addr, unsigned char src);
13. void __data20_write_long(unsigned long addr, unsigned long src);
14. void __data20_write_short(unsigned long addr, unsigned short src);
15. void __delay_cycles(unsigned long);
16. void __disable_interrupt(void); AND __disable_interrupts(void);
17. void __enable_interrupt(void); AND __enable_interrupts(void);
18. unsigned short __get_interrupt_state(void);
19. unsigned short __get_SP_register(void);
20. unsigned short __get_SR_register(void);
21. unsigned short __get_SR_register_on_exit(void);
22. void __low_power_mode_0(void);
23. void __low_power_mode_1(void);
24. void __low_power_mode_2(void);
25. void __low_power_mode_3(void);
26. void __low_power_mode_4(void);
27. void __low_power_mode_off_on_exit(void);
28. void __no_operation(void);
29. void __set_interrupt_state(unsigned short src);
30. void __set_SP_register(unsigned short src);
31. unsigned short __swap_bytes(unsigned short src);
7.2 GCC Function Attribute Support

1. **interrupt(x)**
   Make the function an interrupt service routine for interrupt "x".

2. **signal**
   Make an interrupt service routine allow further nested interrupts.

3. **wakeup**
   When applied to an interrupt service routine, wake the processor from any low-power state as the routine exits. When applied to other routines, this attribute is silently ignored.

4. **naked**
   Do not generate a prologue or epilogue for the function.

5. **critical**
   Disable interrupts on entry, and restore the previous interrupt state on exit.

6. **reentrant**
   Disable interrupts on entry, and always enable them on exit.

7. **noint_hwmul**
   Suppress the generation of disable and enable interrupt instructions around hardware multiplier code.

8 References


2. GDB: The GNU Project Debugger, Free Software Foundation, Inc. (https://sourceware.org/gdb/current/onlinedocs/)
# Revision History

NOTE: Page numbers for previous revisions may differ from page numbers in the current version.

<table>
<thead>
<tr>
<th>Changes from March 30, 2016 to June 16, 2016</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>• Changed partner information from Red Hat to SOMNIUM</td>
<td>7</td>
</tr>
<tr>
<td>• Added Windows 10 in Section 2, Installing MSP430 GCC Compiler</td>
<td>7</td>
</tr>
<tr>
<td>• Updated instruction steps in Section 3.1, Create New Project</td>
<td>11</td>
</tr>
<tr>
<td>• Updated the description of the &quot;Summary of flags set&quot; option in Table 2, MSP430 GCC Settings</td>
<td>14</td>
</tr>
<tr>
<td>• Changed both descriptions in Table 4, MSP430 GCC Settings: Symbols</td>
<td>16</td>
</tr>
<tr>
<td>• Changed the description of the first two entries in Table 10, MSP430 GCC Settings: Diagnostic Options</td>
<td>23</td>
</tr>
<tr>
<td>• Changed the description of the &quot;Summary of flags set&quot; option in Table 12, MSP430 GCC Linker Settings</td>
<td>25</td>
</tr>
<tr>
<td>• Changed the description of the &quot;Summary of flags set&quot; option in Table 17, MSP430 GCC GNU Objcopy Utility Settings</td>
<td>30</td>
</tr>
<tr>
<td>• Changed the list of options in Section 4.3, MSP430 GCC Options</td>
<td>35</td>
</tr>
<tr>
<td>• Added Section 5.2, Building MSP430 GCC (Somnium)</td>
<td>40</td>
</tr>
</tbody>
</table>
IMPORTANT NOTICE

Texas Instruments Incorporated and its subsidiaries (TI) reserve the right to make corrections, enhancements, improvements and other changes to its semiconductor products and services per JESD46, latest issue, and to discontinue any product or service per JESD48, latest issue. Buyers should obtain the latest relevant information before placing orders and should verify that such information is current and complete. All semiconductor products (also referred to herein as “components”) are sold subject to TI’s terms and conditions of sale supplied at the time of order acknowledgment.

TI warrants performance of its components to the specifications applicable at the time of sale, in accordance with the warranty in TI’s terms and conditions of sale of semiconductor products. Testing and other quality control techniques are used to the extent TI deems necessary to support this warranty. Except where mandated by applicable law, testing of all parameters of each component is not necessarily performed.

TI assumes no liability for applications assistance or the design of Buyers’ products. Buyers are responsible for their products and applications using TI components. To minimize the risks associated with Buyers’ products and applications, Buyers should provide adequate design and operating safeguards.

TI does not warrant or represent that any license, either express or implied, is granted under any patent right, copyright, mask work right, or other intellectual property right relating to any combination, machine, or process in which TI components or services are used. Information published by TI regarding third-party products or services does not constitute a license to use such products or services or a warranty or endorsement thereof. Use of such information may require a license from a third party under the patents or other intellectual property of the third party, or a license from TI under the patents or other intellectual property of TI.

Reproduction of significant portions of TI information in TI data books or data sheets is permissible only if reproduction is without alteration and is accompanied by all associated warranties, conditions, limitations, and notices. TI is not responsible or liable for such altered documentation. Information of third parties may be subject to additional restrictions.

Resale of TI components or services with statements different from or beyond the parameters stated by TI for that component or service voids all express and any implied warranties for the associated TI component or service and is an unfair and deceptive business practice. TI is not responsible or liable for any such statements.

Buyer acknowledges and agrees that it is solely responsible for compliance with all legal, regulatory and safety-related requirements concerning its products, and any use of TI components in its applications, notwithstanding any applications-related information or support that may be provided by TI. Buyer represents and agrees that it has all the necessary expertise to create and implement safeguards which anticipate dangerous consequences of failures, monitor failures and their consequences, lessen the likelihood of failures that might cause harm and take appropriate remedial actions. Buyer will fully indemnify TI and its representatives against any damages arising out of the use of any TI components in safety-critical applications.

In some cases, TI components may be promoted specifically to facilitate safety-related applications. With such components, TI’s goal is to help enable customers to design and create their own end-product solutions that meet applicable functional safety standards and requirements. Nonetheless, such components are subject to these terms.

No TI components are authorized for use in FDA Class III (or similar life-critical medical equipment) unless authorized officers of the parties have executed a special agreement specifically governing such use.

Only those TI components which TI has specifically designated as military grade or “enhanced plastic” are designed and intended for use in military/aerospace applications or environments. Buyer acknowledges and agrees that any military or aerospace use of TI components which have not been so designated is solely at the Buyer’s risk, and that Buyer is solely responsible for compliance with all legal and regulatory requirements in connection with such use.

TI has specifically designated certain components as meeting ISO/TS16949 requirements, mainly for automotive use. In any case of use of non-designated products, TI will not be responsible for any failure to meet ISO/TS16949.

Products

<table>
<thead>
<tr>
<th>Category</th>
<th>Website</th>
<th>Applications</th>
</tr>
</thead>
<tbody>
<tr>
<td>Audio</td>
<td><a href="http://www.ti.com/audio">www.ti.com/audio</a></td>
<td>Automotive and Transportation</td>
</tr>
<tr>
<td>Amplifiers</td>
<td>amplifier.ti.com</td>
<td>Communications and Telecom</td>
</tr>
<tr>
<td>Data Converters</td>
<td>dataconverter.ti.com</td>
<td>Computers and Peripherals</td>
</tr>
<tr>
<td>DLP® Products</td>
<td><a href="http://www.dlp.com">www.dlp.com</a></td>
<td>Consumer Electronics</td>
</tr>
<tr>
<td>DSP</td>
<td>dsp.ti.com</td>
<td>Energy and Lighting</td>
</tr>
<tr>
<td>Clocks and Timers</td>
<td><a href="http://www.ti.com/clocks">www.ti.com/clocks</a></td>
<td>Industrial</td>
</tr>
<tr>
<td>Interface</td>
<td>interface.ti.com</td>
<td>Medical</td>
</tr>
<tr>
<td>Logic</td>
<td>logic.ti.com</td>
<td>Security</td>
</tr>
<tr>
<td>Power Mgmt</td>
<td>power.ti.com</td>
<td>Space, Avionics and Defense</td>
</tr>
<tr>
<td>Microcontrollers</td>
<td>microcontroller.ti.com</td>
<td>Video and Imaging</td>
</tr>
<tr>
<td>RFID</td>
<td><a href="http://www.ti-ridf.com">www.ti-ridf.com</a></td>
<td></td>
</tr>
<tr>
<td>OMAP Applications Processors</td>
<td><a href="http://www.ti.com/omap">www.ti.com/omap</a></td>
<td>TI E2E Community</td>
</tr>
<tr>
<td>Wireless Connectivity</td>
<td><a href="http://www.ti.com/wirelessconnectivity">www.ti.com/wirelessconnectivity</a></td>
<td></td>
</tr>
</tbody>
</table>

Mailing Address: Texas Instruments, Post Office Box 655303, Dallas, Texas 75265
Copyright © 2016, Texas Instruments Incorporated